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Plagiarism is the act of taking other people’s words or images and passing them
off as your own. Plagiarism is discouraged because it not only affects the reputation of the author and publication, but also may encourage others to plagiarize
your work and lessen its impact. Plagiarism is also considered intellectual theft,
whether it is done intentionally or accidentally.
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EXAMPLES OF PLAGIARISM AND HOW TO CORRECT IT:
1. Copying text from another source word for word without attribution. Direct
quotations from another source should be in quotation marks and include
citation attribution:
• “The best chance we have of addressing the combined challenges of energy supply and demand, climate change and energy security is to accelerate the introduction of new technologies for energy supply and use and
deploy them on a very large scale” (Friedman 2008, p. 34).
2. Copying data from another source without citing the original source. Data
from another source should include citation attribution:
• For reference, estimates of water-related energy use range from 4% to
13% of U.S. electricity use (Copeland 2014).
3. Reproducing images either from another publication, an industry source, or
the Internet without attribution. All images not created by you need permissions from the copyright holder to be republished. (See the examples of Images Showing Appropriate Attribution.) See Obtaining Permissions for more
details.
4. Using data from another source in an image or table without attributing the
original source of the data. If the data was not collected by the authors publishing the work, it must be cited. (See the examples of Images and Tables
Showing Appropriate Attribution.)
A Note on ASHRAE Publications
Images and data from ASHRAE publications can generally be used in subsequent ASHRAE publications. However, you still must obtain permission to reprint these images and data from ASHRAE, and these images and data must still
be cited appropriately in text, in images, and in tables. To request permission to
use ASHRAE copyrighted content, visit ASHRAE’s website.
A Note on U.S. Government Publications
Images and data from U.S. Government sources can often be used without permission. However, these images and data must still be cited appropriately in text,
in images, and in tables.
A Note on Fair Use
The principle of fair use applies to certain material used in criticism, comment,
news reporting, teaching, scholarship, and research. Fair use generally applies
to information replicated in an educational setting without intent to distribute
or profit from the information, or information that is changed significantly from
its original source. It is better to err on the side of caution and try to obtain
permission rather than risk plagiarism. More information can be found at
www.copyright.gov.
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Requesting permission to reproduce figures and tables from other sources is the
responsibility of the author, as is payment of any fees the copyright holder may
require before granting permission. Authors should never assume that material
taken from software or downloaded from the Internet may be used without obtaining permission. See Avoiding Plagiarism for more information.
1. Permission to reproduce material must be obtained during the writing stage.
2. Classify all information from another source as either “in the public domain” or “requires copyright permission.”
Publications from federal agencies are all in the public domain, which
means the information must be cited in your text and referenced at the end
of your manuscript but you do not have to request permission to use it.
• Material from private publishers—including publishers of your own
previously published work—requires copyright permission. If permission is not granted, you cannot use the material in your manuscript.
»» For all photos, figures, tables, and data from tables from other sources
that require permission, you must cite the source in your text and
reference it at the end of your manuscript in addition to crediting the
copyright holder for permission to use the material.
• NOTE: Table data do not require copyright permission as long as the
table is reformatted. However, the material must still be cited, so reference information is required.
3. For those sources that are not in the public domain, request permission from
the copyright holder to use/reproduce the information.
• Submit a request letter or the completed Permission Request Form to the
copyright holder and ask for a reply within 30 days. They should reply directly to you, not ASHRAE staff.
• To request permission to use ASHRAE copyrighted content, visit ASHRAE’s
website.
4. Be sure to reference all materials from other sources where they appear in
your manuscript, including credit lines as designated by copyright holders.
5. Submit permission-granted letters with the completed manuscript. Material
cannot be published without permission, and no editing or layout work will
begin on the manuscript until all permissions have been received.
•
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ASHRAE retains exclusive copyright of papers published as part of the ASHRAE
Winter or Annual Conference Papers via the ASHRAE Technology Portal and
in ASHRAE Transactions. Works published by ASHRAE are final and complete
works.
Under ASHRAE copyright policies, authors retain the right for certain specific
uses of their paper without requesting ASHRAE’s permission. Only the “as published” version of the paper may be used by the author. These uses are as follows:
• to make copies of the paper for their own personal use;
• to make copies and distribute copies of the paper to researchers or customers of the author’s employer for the personal use by such researchers
or customers;
• to post the paper as published by ASHRAE on the author’s personal,
institutional, or corporate website or server with a link to ASHRAE’s
website;
• to present the paper (after ASHRAE publication) at a meeting or conference and to distribute copies of such paper to the delegates attending the
meeting with written permission from ASHRAE;
• to allow use of the paper by the author’s employer for posting on the employer’s website, for use by the employer in training or educational courses offered by the employer, for internal research work that is conducted
by the employer, and for internal publications published by the employer;
• to include the paper in full or in part in a thesis or dissertation;
• to include the paper in a printed compilation of works of the author, such
as collected writings or lecture notes; and
• to prepare other derivative works, such as extending the paper into booklength form, or to otherwise re-use portions or excerpts in other works,
providing there is acknowledgement of its publication by ASHRAE.
Other uses must be authorized by ASHRAE. Authors should contact ASHRAE
explaining their specific need and identifying the paper and ASHRAE publication
in which the paper appeared.
Others wishing to use ASHRAE copyrighted content should visit ASHRAE’s
website for more information and to make their request.
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1. Original figures or other artwork should be submitted with the manuscript
whenever possible. For information on reprinting a figure from another
source, see Obtaining Permissions.
2. Use only 1 point (0.014 in. [0.35 mm]) or thicker lines—smaller lines will
not reproduce well.
3. Figures to be reproduced in black and white should use patterns or shapes
to distinguish sections instead of coloring and shading. Figures to be reproduced in color should have touching colors that differ significantly so that
there can be no confusion in understanding the data. (Note that papers are
published in color as part of the ASHRAE Winter or Annual Conference Papers in the ASHRAE Technology Portal and in black and white in ASHRAE
Transactions.)
4. Each figure should have a brief legend or descriptive labels, as appropriate.
Any text included in a figure (except the figure caption) should be embedded as part of the image file and not contained in a separate text box
that is not part of the image file.
5. Provide dual units for all measurements, preferably as two figures.
6. All figures must be provided to ASHRAE as individual TIF (preferred) or
EPS files in either CMYK mode (for color) or Grayscale mode (for black
and white). All images should be saved at high resolution (600 dpi for line
art ; 300 dpi for photographs) and at least 4 in. (102 mm) size or greater. See
Converting Graphics Created in Excel or Word for instructions on graphic
conversion. Figure files should be clearly labeled (i.e., Figure1.tif, Fig2.tif,
Fig3-2, etc.). Multiple-part figures, such as a figure with parts (a) and (b), must
be submitted as one file with all parts included.
7. Every figure must be referenced in the text by name/number, where “Figure”
is capitalized (e.g., “…as shown in Figure 2.”).
8. Figures must be numbered consecutively as they appear in the text.
9. Prepare a list of captions for figures and place it at the end of the manuscript
(this applies to papers only; it is not applicable for book projects).
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1. All table titles should be descriptive but concise.
2. Original tables should be submitted with the manuscript whenever possible.
For information on reprinting a table from another source, see Obtaining
Permissions.
3. Titles appear above the tables, and every major word in the title is capitalized.
4. Number tables consecutively and in the order they are mentioned in the
text.
5. Tables used in the manuscript should not be image files but should be
editable tables (such as those created in Word, Excel, Framemaker, InDesign,
etc.).
6. Use only 1 point (0.014 in. [0.35 mm]) or thicker lines—smaller lines will
not reproduce well.
7. Vertical and horizontal lines should be avoided except to delineate the top
and bottom of a table and to separate the heading row from the data, unless
lines are otherwise necessary for clarity or organization of the data.
8. Label each column with a heading and include units of measurement and
other necessary qualifying information. Units should be set off with a comma (e.g., “Velocity, m/s”).
9. Provide dual units for all measurements.
10. Every table must be referenced in the text by name/number, where “Table” is
capitalized (e.g., “as provided in Table 5”).
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ASHRAE policy requires dual units of measurement—inch-pound (I-P) and
International System of Units (SI). You are required to provide dual units when
submitting manuscripts; ASHRAE staff will not convert units for you. See
ASHRAE’s SI Guide for HVAC&R for comprehensive guidance on using SI
units. Some guidelines are as follows:
1. The units used in calculating the work being reported should be listed first
with the alternate system of units following in parentheses.
2. Always spell out all units when they are used without a number.
3. Do not mix symbols and names in the same expression.
4. Do not express plurals by adding an “s”.
5. Do not use periods with units of measurement.
• EXCEPTION: in. for inch
6. Leave a space between the numerical value and the unit of measurement.
EXCEPTION: There is no space between number and degree of plane angle
or degrees of temperature (45°, 62°F, 20°C) or the number and the percent
symbol (5%).
7. “L” is the symbol for litre, not lowercase “ell” or script “ell.”
8. “Centi-” is not an acceptable SI prefix, and the use of cm should be avoided.
9. For currency, include the monetary unit of the country where the research is
based followed by the U.S. dollar conversion in parentheses.
•
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Each significant equation or formula should be displayed on a separate line. Center
equations and place consecutive equation numbers flush right in parentheses.
EXAMPLE:
		
		
		
		
		

a2 + b2 = f 2

(1)

where
a2 = apples
b2 = bananas
f 2 = fruit salad

If an equation requires more than one line, break it before an operational sign,
and align the operational signs on the left.
EXAMPLE:
		
		

E = (a + b + c)/(m + n + o)
× d + e + f)

(2)

If two or more displayed equations are grouped together, leave space between
the individual equations:
		
a+b=c
(3)
		

D = f – ab2

(4)

		
mon + rst
(5)
Spell out the word “equation” and capitalize it in the text when referring to specific, numbered equations. In a highly mathematical or theoretical work, consider
developing equations in appendices rather than in the body of the manuscript.
Please note that all equations must be retyped in our pagemaking program—
this is one reason we require a hard copy of the manuscript—and therefore
should be checked thoroughly by the author at the proofreading stage.
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Most books are the result of an ASHRAE research project. A subcommittee may
be designated to handle the review process of a committee-sponsored project,
using committee members or other persons with expertise in the area of concern.
The ASHRAE submittal, review, and publication process proceeds as follows:
1. The author indicates intent to submit a manuscript to Special Publications
and receives the Authors’ Manual.
2. The author prepares the manuscript, including artwork, according to this Authors’ Manual.
3. The cognizant ASHRAE Technical Committee selects qualified reviewers.
4. Reviewers send reviews and comments to the author.
5. The author revises the manuscript and/or rebuts comments and provides a
revised manuscript or rebuttal to the cognizant Technical Committee.
6. Reviewers complete an additional review.
7. The review process continues until the manuscript is accepted or rejected for
publication by the cognizant Technical Committee.
8. After the manuscript is approved for publication, the author submits a final
Microsoft® Word file and separate figure files electronically to Special Publications (see Book Submission Guidelines) and the author is informed of a
tentative publication schedule.
9. Special Publications editors edit the manuscript for grammar, punctuation,
clarity, and consistency with ASHRAE policies, as well as completeness of
parts. It is then laid out into pages, with the figures and tables incorporated.
10. The editors send a PDF proof to the author, often including queries that
require responses from the author. The author proofreads the manuscript
and returns replies to the editors’ queries within a mutually agreed upon
(hopefully short) timeframe.
11. The book is published and offered for sale in the ASHRAE Bookstore as
both the physical, printed book and a PDF available for download.
12. The author receives a complimentary copy of the published book.
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Technical Paper and Conference Paper submittal, review, and publication activity is coordinated by the ASHRAE Conference Program Administrator. The
papers publication process proceeds as follows:
1. The author indicates intent to submit a paper to the ASHRAE Conference
Program Administrator and receives instructions and the Authors’ Manual.
2. The author prepares the paper, including artwork, according to the Authors’
Manual and the Author’s Template for Technical Papers or the Author’s Template Conference Papers.
3. The author uploads the paper through the applicable website as indicated
in the Technical Papers Submission Requirements and Conference Papers
Submission Requirements.
4. The ASHRAE Conference Program Administrator selects qualified reviewers.
5. The reviewers carefully review the paper and submit reviews online.
6. The author receives reviews and comments. The author revises the paper
and/or rebuts the comments and uploads a revised paper or rebuttal.
7. The reviewers are notified that a revised paper requires additional review.
8. The review process continues until the paper is accepted or rejected.
9. After the paper is accepted, the author uploads the final paper through the applicable website in the appropriate format as indicated in the Technical Papers
Submission Requirements and Conference Papers Submission Requirements.
10. The accepted paper is scheduled for presentation at an ASHRAE Winter or
Annual Conference or a Topical Conference.
11. ASHRAE staff editors edit and format the Technical Paper and send a PDF to
the author, who proofreads the paper and returns responses to the editors’ queries by the supplied deadline, or staff editors scan the Conference Paper for
adherence to the Author’s Template for Conference Papers and the author addresses any noted errors and provides a revised PDF by the supplied deadline.
12. After the conference editors may send the author of a Technical Paper comments and questions generated at an ASHRAE Winter or Annual Conference. The author returns responses to the editors.
13. Technical Papers are available as preprint PDFs in the ASHRAE Winter or
Annual Conference Papers in the ASHRAE Technology Portal and published
as final paper with the questions and comments and authors’ responses in
ASHRAE Transactions, Conference Papers are published as final PDFs in the
ASHRAE Winter or Annual Conference Papers in the ASHRAE Technology
Portal, and papers for Topical Conferences are published as PDFs on flash
drives or downloads for the individual conferences. All papers are available
for purchase from the ASHRAE Bookstore as downloadable PDFs.
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The following materials are required for book manuscript submission:
1. The complete manuscript in Microsoft® Word and the figures provided as
separate TIF or EPS files saved at high resolution. Tables should be editable
and NOT submitted as images.
2. A laser printout of the complete manuscript including text, tables, and graphics.
With the printout, include a cover sheet with the following information:
• Proposed title of the book
• Whether the book will include supplemental materials online (Excel
spreadsheets, PDFs, Word files, etc.)
• Sponsoring ASHRAE Technical Committee and/or ASHRAE research
project number, as applicable
• Author names in desired order with (if applicable) ASHRAE membership grade, academic degrees at the doctoral level, and professional
certifications for each author
• An “About the Authors” paragraph
• Complete contact information for the corresponding author, including
mailing address, phone and fax numbers, and email address
• A paragraph describing the book (to be used on the back of the book, in
the bookstore, and in marketing materials)
3. Electronic or printed copies of any permissions granted for reproducing material from other sources (see Obtaining Permissions)
4. The completed Marketing Questionnaire
See Document Formatting and Book Organization for additional requirements.
Manuscripts should be submitted to:
		Cindy Michaels
		 Editor, Special Publications
		 1791 Tullie Circle NE, Atlanta, GA 30329 USA
		cmichaels@ashrae.org
		Telephone: 678-539-1187
Book Publication Process provides information on how the process will proceed
after submission of the manuscript to Special Publications.
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Technical Papers most often report on ASHRAE-sponsored research and unsolicited research in HVAC&R technical areas.
All Technical Papers undergo critical, double-blind peer review by three or more
competent specialists to ensure high quality of content. A paper must be accepted
by three reviewers to be approved for an ASHRAE Winter or Annual Conference.
The Technical Paper review activity is coordinated by the ASHRAE Conference
Program Administrator, who can be contacted if you have any questions during
the paper submission and review process. File submission is done online via
Manuscript Central. Manuscript Central Upload Instructions are available in
the “Instructions & Forms” section of that website.
The Technical Paper submission requirements are as follows:
1. Upload an Agreement to Publish form that is signed by the main author.
2. Download the Authors’ Template for Technical Papers for a Microsoft®
Word file to use when writing the paper; also see an example paper.
3. Typed manuscripts for Technical Papers must not exceed 30 double-spaced
pages (including references and tables) and can contain a maximum of 12
figures. Dual units of measurement should be included in the text, tables,
and figures. See Document Formatting for additional requirements. Upload
the paper as a Microsoft® Word file for review. Authors should NOT identify
themselves in manuscript files to enable reviewers to maintain a blind review.
4. Upload an author’s list as a separate Word file that includes the following:
• The title of the paper
• Author names in desired order, principal author first, with (if applicable)
ASHRAE membership grade, academic degrees at the doctoral level, and
professional certifications for all authors.
• An author note with job title, affiliation, and address for each author.
• Complete contact information for all authors.
Reviews will be done using ASHRAE’s online review process, and ASHRAE
staff editors will edit and lay out the accepted Technical Paper. (See Paper Publication Process for more information.) The corresponding author of the paper
will receive a complimentary print copy of the published paper for distribution
to all authors.
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Conference Papers presented at ASHRAE Winter or Annual Conferences report
on research in progress, applications, case studies, and other topics in HVAC&R
technical areas. Conference Papers presented at Topical Conferences report on
specific technical areas within HVAC&R, depending on the conference.
Annual/Winter and Topical Conference Papers undergo single-blind review (unless otherwise indicated in the call for papers) by two or more reviewers to ensure
high quality of content. A paper must be accepted by two reviewers to be approved for a conference. The Conference Paper review activity is coordinated by
the ASHRAE Conference Program Administrator, who can be contacted if you
have any questions during the paper submission and review process. File submission is done online via ConfTool or Conference Exchange (2019 Annual
Conference only) using the link provided for each individual conference.
The Conference Paper submission requirements are as follows:
1. Upload an abstract for review. The abstract must be accepted before the paper can be submitted. When you upload your abstract you will be assigned
an ID# for your submission (one ID# for both the abstract and the paper).
2. Upon acceptance of the abstract, submit the paper based off of the accepted
abstract.
• Download the Authors’ Template for Conference Papers for a Microsoft®
Word file to use when writing the paper; also see an example paper.
• Conference Papers must not exceed eight single-spaced pages in length
(including references, tables, and figures) and must include an author
note at the bottom of page 1. Dual units of measurement should be included in the text, tables, and figures. See Document Formatting for additional requirements. Conference Papers being submitted should be
considered “Final” by the author. Upload the Conference Paper as a PDF
with your assigned ID# as the file name.
• Please note that adherence to the Author’s Template and to the requirements set forth in this Authors’ Manual are significant factors
in determining the acceptance of your Conference Paper.
3. Upload an Agreement to Publish form signed by the presenting author.
Reviews will be done using ASHRAE’s online review process. (See Paper Publication Process for more information.)
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Extended Abstracts presented as part of the Research Track at ASHRAE Annual Conferences report on research in progress, applications, case studies, and
other topics in HVAC&R technical areas. Extended Abstracts are intended to be
preliminary research results that will eventually be expanded into a full paper.
Extended Abstracts undergo single-blind review by two reviewers to ensure high
quality of content. An abstract must be accepted by two reviewers to be approved
for a conference. The Conference Paper review activity is coordinated by the
ASHRAE Conference Program Administrator, who can be contacted if you have
any questions during the paper submission and review process. File submission
is done online via ConfTool using the link provided for each individual conference.
The Extended Abstract submission requirements are as follows:
1. Upload an abstract for review. The abstract must be accepted before the Extended Abstract can be submitted. When you upload your abstract you will
be assigned an ID# for your submission (one ID# for both the abstract and
the Extended Abstract).
2. Upon acceptance of the abstract, submit the Extended Abstract based off of
the accepted abstract.
• Download the Authors’ Template for Conference Papers for a Microsoft®
Word file to use when writing the paper; also see an example paper.
• Extended Abstracts must not exceed three single-spaced pages in length
(including references, tables, and figures) and must include an author note
at the bottom of page 1. Dual units of measurement should be included
in the text, tables, and figures. See Document Formatting for additional
requirements. Extended Abstracts being submitted should be considered
“Final” by the author. Upload the Extended Abstract as a PDF with your
assigned ID# as the file name.
• Please note that adherence to the Author’s Template and to the requirements set forth in this Authors’ Manual are significant factors
in determining the acceptance of your Extended Abstract.
3. Upload an Agreement to Publish form signed by the presenting author.
Reviews will be done using ASHRAE’s online review process. (See Paper Publication Process for more information.)
Extended Abstract authors must give an oral presentation based on the accepted
work as part of the ASHRAE Anual Conference Research Track. Accepted Extended Abstracts will be published in Part 2 of ASHRAE Transactions.
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“Figures to be reproduced in black and white should use patterns or
shapes to distinguish sections instead of coloring and shading.”

Sample Figures

“Figures to be reproduced in color should have touching colors that differ
significantly so that there can be no confusion in understanding the data.”
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PERFORMANCE EVALUATION FUNCTION

First Level

The performance of any air-conditioning system depends on two factors:
a. thermal comfort

Heading Level
Samples

797

b. energy consumption

Second Level

Thermal Comfort
The most important variables that influence the condition of thermal comfort are air temperature, water vapor pressure in ambient air, relative air velocity, mean radiant temperature, activity
level (heat production in the body), thermal resistance of the clothing, and purity of the air.
Fanger (1970) defined a thermal sensation index by considering air temperature, water vapor
pressure in ambient air, relative air velocity, mean radiant temperature, activity level, and thermal resistance of the clothing. PMV is the thermal sensation index given by Fanger (1970) and
is internationally standardized. It is easy to use PMV when controlling an air-conditioning system because PMV is an index of human thermal sensation with one value for all seasons and is
effective for all temperatures that are neither extremely high nor extremely low. PMV ranges
from –3 (cold) to +3 (hot). When PMV is zero, then thermal sensation will be neutral, i.e., neither cold nor hot. Broadly speaking, when PMV approaches zero then thermal comfort
increases.
The first term on the right-hand side of Equation 14 indicates the mass of moisture in the
incoming air, which comes in contact with the evaporator wall, and the mass of moisture in the
outgoing air. The humidity of the incoming air is calculated from a psychrometric chart with the
help of the second-order curve-fitting method. The multiplying factor, (1 – b), corresponds to
the bypass factor of the evaporator. The second term amounts to mass of moisture in the incoming air bypassed through the evaporator and the mass of moisture in the outgoing air. The multiplying factor b corresponds to the bypass factor of the evaporator. The rate of change of specific
humidity of supply air when the evaporator wall temperature is more than the dew-point temperature is given by
( ρ a V d )dW s ⁄ dt = vρ a ( ( 1 – ξ )W 3 + ξW 0 – W s ) .

(1)

The first two terms on the right-hand side of Equation 15 correspond to absolute or specific
humidity of incoming air, and the third term corresponds to outgoing supply air humidity.
Specific Humidity of Thermal Space. The rate of change of the specific humidity of the
thermal space is given by

Third
Level
( ρ a V s )dW 3 ⁄ dt = vρ
a ( W s – W3 ) + M0 .

(2)

The first term on the right-hand side of Equation 16 corresponds to the change in humidity
due to the supply air humidity W , and the second term on the right-hand side corresponds to
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ASHRAE requires that prospective authors sign an Agreement to Publish form
that gives ASHRAE the copyright and permits ASHRAE to publish the manuscript, to reprint it, and to offer it in whole or in part for reproduction or translation. ASHRAE must have the author’s written permission and assignment of
copyright (for papers) before a manuscript can be processed for publication.
For books this is likely covered by a publications contract or a research project
agreement; for papers, authors must complete the Agreement to Publish
form and either mail it to the address or fax it to the number provided
on the form or upload it to Manuscript Central (preferred). Authors shall
not submit manuscripts that are or will be considered for publication by other
organizations or publishers.
It is the author’s responsibility to secure and transmit to ASHRAE written permissions for use of proprietary information and/or copyrighted materials appearing in the manuscript prior to its submission. (See Obtaining Permissions
and Avoiding Plagiarism for more information.)
ASHRAE requires previously unpublished papers in all its publications. Prior
publication of papers in publications that are indexed or widely available from
retrievable sources (including ASHRAE Journal and Science and Technology
for the Built Environment) usually precludes consideration for presentation at
Society conferences or for publication in ASHRAE Transactions.

Below are steps for converting figures created in Microsoft® Excel or Microsoft® Word into TIF files. For additional information see Formatting Figures.
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1. In Excel, select the chart or graph to be converted. In Word, select the
image to be converted. (Please be sure all elements are grouped together
before copying.)
If using Excel 2010 or Word 2010 or newer:
• From the Home tab, select “Copy.”
If using Excel 2007 or Word 2007:
• From the menu options select “Copy.”
If using an older version of Excel:
• Hold down the Shift key and from the menu options select “Edit.”
• Choose “Copy Picture” from the drop-down Edit menu.
• Select “As shown when printed,” then “OK.”
If using an older version of Word:
• From Word’s menu options, choose “Edit” then “Copy.”
2. Minimize Excel or Word (don’t close it).
3. Open Microsoft® PowerPoint.
If using PowerPoint 2007 or 2010 or 2013:
• Delete the two boxes showing on the blank page that opens.
• From the PowerPoint menu options, under the Design tab, for 2007 select
“Page Setup” and for 2010 or 2013 select “Slide Size” then “Custom
Slide Size.”
• Set the width for 24 in. and the height for 24 in. and choose “OK.”
• From the PowerPoint menu options (under the Home tab for 2010 and
2013), select the drop-down arrow below the “Paste” button and select
“Paste Special” then “Picture (Enhanced Metafile).” Please make sure all
elements were copied over into PowerPoint.
If using an older version of PowerPoint:
• Choose “Blank Presentation,” then “OK.”
• Choose the icon showing a completely blank slide (or page); choose “OK.”
• Under the File menu options, choose “Page Setup.”
• In Page Setup, set width at 36 in. and height at 24 in. for landscape layout
and set width at 24 in. and height at 36 in. for portrait layout. Choose “OK.”
• From the PowerPoint menu options, choose “Edit, Paste Special.”
• Choose “Picture (Enhanced Metafile).”
4. Select the image you pasted into PowerPoint. Small squares will appear on
all four corners. These are handles. Use one of the corner handles to stretch
the image to fill the page, but be sure to hold down the shift key as you
stretch the handle so that the image proportions will remain intact. Do
not stretch the image off the page.
5. Under the File menu option, choose “Save As.” If using PowerPoint 2013,
choose “Browse” and navigate to the desired location for saving the file.
6. In the Save As dialog window, choose “TIFF Tag Image File Format (*.tif)”
from the Save As Type drop-down list. Give the file a name and click “Save.”
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Foreword. Optional; usually written by someone other than the author.

Book Organization

Preface. The preface is the author’s statement about the work. It may include
general background information, such as reasons for undertaking the work, the
origins of the book (not the subject matter), and the method of research (if it has
some bearing on readers’ understanding).
Acknowledgments. The section may acknowledge special assistance, including sources of financial aid, as well as the help of ASHRAE Technical Committees, individuals, or other groups.
Introduction. This section should contain an overview of the book. The definition of the problem should be set in the appropriate framework for the solution
that will follow in the main body of the text.
Chapters. Most books are organized in chapters, which should have short, descriptive titles. The material should be presented in a logical order that is easy to
follow, keeping the prospective audience in mind. Authors may use sections with
appropriate subheadings within chapters.
Reports of experiments should include an estimate of uncertainty and an error
analysis. Any results described should include qualifications, limits to the accuracy
of tests and calculations, and other problems.
There should be a conclusion to the book, which should list conclusions and
summarize the significance of the work as clearly and concisely as possible.
Nomenclature. When equations are used extensively, the author should consider having a special nomenclature section. Otherwise, nomenclature can follow each equation.
References and Bibliography. ASHRAE’s preferred method of citation,
widely used in scientific texts, is the author-date method.
Appendices. Appendices may include supporting data, sample calculations,
derivations of complicated mathematical equations, detailed descriptions of apparatus, and a glossary of terms.
Index. Authors are asked to submit a list of words that will be compiled to create an index. (The author need not supply page numbers—only the words they
want indexed.)
Supplemental Materials Online. Authors may wish to include for their readers supplemental materials that are best presented in a nonprint format. These
materials should be submitted in final form in the desired format and will be provided to readers via a dedicated, non-crawlable web address printed in the book.
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Part I, Part II, etc. in the title.
Abstract. Abstracts should be between 100 and 200 words and concisely state the
nature of the research, methods, major findings, and conclusions. For Technical
Papers, the abstract must be included in the body of the paper and uploaded to
Manuscript Central in the “Abstract” section.
Introduction. Introductions should contain general background information, literature review, and/or events that led to the work reported.
Body. The body should include, in order, experimental designs, test procedures,
theoretical consideration, and results. Sections with appropriate subheadings
should describe the test equipment, measurements, observations, and mathematics
needed to perform the experiments.
Discussion. Results described in the preceding section should be discussed here,
including qualifications, limits to the accuracy of tests and calculations, and other
problems.
Conclusion. This section should list conclusions and summarize the significance
of the paper as clearly and concisely as possible.
Acknowledgments. Acknowledges special assistance. Persons mentioned
should be identified with their affiliations.
Nomenclature. Use a special nomenclature section when equations are used
extensively.
Appendices. Appendices may include supporting data, sample calculations, derivations of complicated mathematical equations, and detailed descriptions of apparatus. Material in the appendices count in the page and figure limitations.
Computer Programs. Lengthy programs or printouts are approved only under
exceptional circumstances.
References and Citations. ASHRAE’s preferred method of citation, widely
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Figures and Tables. Figures and tables duplicated for units purposes count
as a single figure when determining the maximum number of figures for Technical Papers. Figures may be inserted into the Microsoft® Word text file for the
review process and for final submission; for final submission please also insert
them at the end of the document or in a separate Word file.

For the final stage of a manuscript, only a Microsoft® Word file free of conditional
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See Formatting Figures
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Manuscripts should be double-spaced and in a single-column format on 8 1/2 by
11 in. (216 by 279 mm) or A4 sheets, with 1 in. (25 mm) margins.
Headings
ASHRAE publications provide for three levels of headings. If a fourth level is needed, use the third-level heading with only the first word capitalized.
Lists
Indent items in a list, preceded by a number and period. Introduce all lists.
EXAMPLE:
The HVAC system was designed to accommodate the following:
1. Placement of research equipment and walls anywhere in the laboratory
without major modification
2. Minimal energy consumption
Short listed items may be indented and preceded by a bullet.
EXAMPLE:
... are the following:
• relative equipment first cost,
• relative future cost of gas and electric energy, and
• relative amounts of heating and cooling loads.
Separate items in a list within text using numbers in parentheses.
EXAMPLE:
... the following: (1) relative equipment first cost, (2) relative future cost of gas
and electric energy, and (3) relative amounts of heating and cooling loads.
Numbers
Always use numeric figures with scientific and mathematical abbreviations:
• 4 ft, 12 in., 2 m, 3 m2
• Use only Arabic numbers.
• Spell out the numbers one to ten in the text; use the numeral for any
number over ten.
• Four-digit numbers need no comma (1200).
Acronyms
Acronyms should not be used without first giving the full expanded name.
EXAMPLE:
“…measurement of the entering water temperature (EWT). Record the EWT for
each….”
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References
A reference list is composed only of works cited in the text, and a bibliography
is a general reading list—the two should not be combined.
•
•

Do not write titles from memory.
Verify all references against the source and be sure that the authors’
names are spelled correctly, that the title is written as it appears in print,
and that correct volume, issue, and page numbers and dates are listed.
• Use the most current edition of a reprinted book whenever possible.
• The reference list at the end of the manuscript should not be numbered.
• Entries are arranged in alphabetical order, chronologically for a particular author or group of authors.
• All authors are listed in a reference list entry. Any “a” or “b” designations that were used in the text to differentiate references to more than
one publication by the same author with the same date should also be
included in the reference list entries.
Citations
ASHRAE’s preferred method of citation, widely used in scientific texts, is the
author-date method.
•
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In the text, cite a source by enclosing the author’s name and the date
(year) of publication in parentheses.
EXAMPLE: “... of such flow were clearly defined (Bailey 1951); however, ...”
Two authors’ names may be included; for three or more, use “et al.” after
the first author’s name.

EXAMPLE: “... a feeling of thermal comfort may be associated with
phenomena other than thermal conditions alone (Winakor and Foster
1978; Woods et al. 1982).”
• In situations where there are references to more than one publication by
the same author or group of authors with the same date, differentiate between the works by adding “a”, “b”, etc. after the date.
		EXAMPLE: “as cited in previous studies (Carey et al. 2001a, 2001b).”
•

If the author’s name has just been mentioned, only the date need be
inserted in parentheses.

		EXAMPLE: “... were clearly defined by Bailey (1951); however, ...”
•

If the “author” is an organization, use its acronym.

		EXAMPLE: (ASHRAE 2005)
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on Electronics Materials and Packaging, Tokyo, Japan, 5:275–81.
Software
LBNL. 1993. DOE-2, Version 2.1E. Berkely, CA: Lawrence Berkeley National
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Seminar or Presentation at a Conference
Lu, D.W., X.N. Xu, H.B. Wu, and X. Jin. 2005. A permanent magnet magnetorefrigerator study on using Gd/Gd-Si-Ge alloys. Presented at the First International Conference on Magnetic Refrigeration at Room Temperature,
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Website
Rice, K. 2006. DOE/ORNL heat pump design model, Mark VI Version. Heat
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Personal Communication
Zimm, C.B., V.K. Pecharsky, K.A. Gschneidner, Jr., S.A Nikitin, and A.M.
Tishin, with Astronautics Inc., Madison, WI. Telephone conversation with
the author, April 17, 2006.
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